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Kurzfassung

Hier wird der Inhalt der Arbeit auf maximal einer Seite zusammengefasst. 



Abstract

Hier wird die Kurzfassung der Arbeit auf Englisch verfasst. 
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1 Einleitung

1 Einleitung

Die Einleitung beschreibt den Aufbau der Arbeit, die Motive zu Ihrer Erstellung, die 

wissenschaftliche Herangehensweise an die Problemstellung sowie formale technische und ggf. 

rechtliche Rahmenbedingungen.
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2 Hinweise zum Textteil

2 Hinweise zum Textteil

2.1 Allgemeines

Allgemein orientieren sich Aufbau und Gestaltung der Diplomarbeit an den Normen zur Gestaltung 

wissenschaftlicher Arbeiten, siehe DIN 1421, 1422, 1502, 5008.

Die Diplomarbeit ist auf weißem Papier im Format A4 entsprechend den Richtlinien zur 

Textverarbeitung (DIN 5008, Duden) zu verfassen und zu binden.

Beleg- und Diplomarbeiten sind wissenschaftlich-technische Dokumentationen, die allgemeinen 

Anforderungen bezüglich Struktur und Form entsprechen müssen. Sie sollen sich durch Klarheit im 

Ausdruck, guten Stil und einwandfreie Orthografie auszeichnen. Formulierungen sind sorgfältig zu 

wählen. Das betrifft auch die Verwendung fremdsprachiger Begriffe.

Die Arbeit ist logisch zu gliedern.

Der/die Schreibende soll einen anspruchsvollen wissenschaftlich-technischen Inhalt verständlich 

vermitteln. Dazu ist es erforderlich, sich immer wieder in die Position der Leserinnen und Leser zu 

versetzen und die Darstellung in dieser Hinsicht zu hinterfragen.

Das Bild, d. h. Prinzipskizze, Diagramm, Foto, Flussdiagramm, Tabelle etc., ist die „ Sprache des 

Ingenieurs“ und sollte langen Erklärungen vorgezogen werden.

Ergebnisse müssen rückverfolgbar sein. Dazu sind die angewandten Methoden, Annahmen, 

Randbedingungen, experimentellen Einrichtungen und Programme sowie relevante 

Zwischenergebnisse zu nennen und in einem angemessenen Umfang zu erläutern.

Auch Berechnungen sind so zu dokumentieren, dass die Gutachterinnen und Gutachter ihre 

Richtigkeit überprüfen können.

Die Darstellung sollte sich auf das Wesentliche konzentrieren und frei von allgemein bekannten 

Abhandlungen und „ Füllstoff“ sein, die nur vom Thema ablenken und den „ roten Faden“ verlieren 

lassen.

Der Arbeit ist eine schriftliche Erklärung beizufügen, dass sie selbständig angefertigt wurde und 

keine anderen als die angegebenen Unterlagen verwendet wurden.

(nach [2], siehe Vorlage in diesem Dokument)

2.2 Gliederung

Der Textteil der Arbeit besteht aus:

— Einleitung

— ggfs. Stand der Technik inkl. Literaturrecherche

— Hauptteil mit Unterabschnitten

— Zusammenfassung und Ausblick

Welche Form der (Unter-)Gliederung am sinnvollsten ist, hängt stark vom jeweiligen Thema ab. 

Bitte halten Sie deshalb nicht um jeden Preis an einer vorgegebenen Gliederung fest und sprechen 

Sie im Zweifelsfall mit Ihrem/r Betreuer/in.
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2 Hinweise zum Textteil

2.3 Formatierung

Für studentische Arbeiten ist das Layout „ article“ zu verwenden. Dies entspricht der Voreinstellung.

2.3.1 Allgemeines

Alle Einstellungen in der Preambel sind dieser Vorlage zu entnehmen. Fertigen Sie sich eine Kopie 

dieser Datei an. Benennen Sie diese dann um und löschen vorsichtig, Absatz für Absatz die Texte. 

Behalten Sie die sich automatisch aktualisierenden Verzeichnisse und Nummerierungen bei. Das 

vereinfacht den Einstieg in die Arbeit.

2.3.2 Formatvorlagen

Die Voreinstellung des Layouts führt zu nachstehenden Formatierungen:

— Standard: Fließtext

— \caption{Beschriftung}: Beschriftungen von Tabellen oder Abbildungen innerhalb des 

Environments figure oder tabular

— \section{Überschrift}: Überschriften 1. Ebene, mit Nummerierung, erscheint im 

Inhaltsverzeichnis

— \subsection{Überschrift}: Überschriften 2. Ebene, mit Nummerierung, erscheint im 

Inhaltsverzeichnis

— \subsubsection{Überschrift}: Überschriften 3. Ebene, mit Nummerierung, erscheint im 

Inhaltsverzeichnis

— (Überschrift 4: Überschriften 4. Ebene, mit Nummerierung, erscheint im Inhaltsverzeichnis 

(Die maximale Gliederungstiefe für studentische Arbeiten beträgt jedoch 3 Ebenen, sodass 

diese Formatvorlage nicht verwendet werden sollte!))

— \section*{Überschrift}: Überschrift 1. Ebene, ohne Nummerierung, erscheint im 

Inhaltsverzeichnis mit diesem Befehl:

\addcontentsline{toc}{section}{Literaturverzeichnis}

— \section*{Überschrift}: Überschrift 1. Ebene, ohne Nummerierung, erscheint nicht im 

Inhaltsverzeichnis

2.3.3 Absätze und Überschriften

Unter Hauptüberschriften der Ebene 1, die mit Überschriften der Ebene 2 weiter unterteilt werden, 

wird kein Text eingefügt. Es sind entsprechende „ Einleitungs-Unterkapitel“ einzufügen.

Es ist der Blocksatz zu verwenden.

2.3.4 Schriftgröße und Zeilenabstand

In den jeweiligen Fließtexten sind Schriftgröße (mind. 10) und Zeilenabstand (1,5) geregelt. Als 

Schriftart ist Noto Sans zu verwenden (kostenlos, keine Standard-Windowsschrift). Die Schriftart 

kann hier heruntergeladen werden:
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2 Hinweise zum Textteil

https://intranet.tu-dresden.de/spaces/TUDMarke/pages/403965504/Schrift

2.3.5 Abkürzungen und physikalische Größen

Sämtliche Abkürzungen sind mit ihrer ersten Verwendung einzuführen und entsprechend im 

Abkürzungsverzeichnis aufzunehmen.

Die Auflistung im Abkürzungsverzeichnis gilt nicht für im Duden beschriebene Abkürzungen wie 

„ z. B.“ oder „ etc.“. Mehrere einzelne Wörter wie „ z. B.“ oder „ u. a.“ sind durch ein Leerzeichen 

(empfohlen wird zur Vermeidung des „Auseinanderziehens“ die Verwendung eines geschützten 

Leerzeichens, in LATEXmit der Tilde: ̃ ) getrennt. (nach [3])

Bei Einheiten ist die Package siunitx zu verwenden. (Beispiele: 5,67 W m−2 K−4, 9,6 MJ/kg, 12,0 ⋅
10−6 K−1, 100 °C, 26 %, jedoch: 90°)

Physikalische Größen sind in Maßeinheiten des internationalen Einheitensystems (SI) anzugeben, d. 

h. bei Verwendung historischer oder anglo-amerikanischer Quellen mit Nicht-SI-Einheiten (z B. atü, 

mmWS, Torr, psi, °F, kcal, PS, ft, ...) entsprechend umzurechnen. Die Umrechnung ist in jedem Fall in 

der Arbeit zu dokumentieren. Einheiten werden nicht kursiv geschrieben.

2.4 Rechtschreibung und Grammatik

Die studentische Arbeit ist in der Regel in deutscher Sprache und dabei nach den Regeln der 

deutschen Rechtschreibung anzufertigen. Auch das Verfassen auf Englisch ist (je nach Studiengang 

und –ordnung) teilweise möglich – fragen Sie hier bitte Ihre/n Betreuer/in.

2.5 Quellen und Zitate

Es ist ein Quellenverzeichnis in dem Dokument quellen.bib zu führen.

Dieses ist im main.tex schon verlinkt und wird mit jedem durchführen des „ Build“ Befehls aktualisiert.

Wörtlich zitiert wird in Anführungszeichen mit einem Quellenverweis. Dies Erfolg über den Befehl 

\textcquote{quelle}{zitierter Abschnitt}, wie im Beispiel:

Nach Meinung vom Verfasser wird „ … wie hier zu sehen, wörtlich zitiert“ [3].

Enthält das Zitat bereits einen abschließenden Satz-Schluss-Punkt, wird nach der schließenden 

Klammer der Quellenangabe kein Punkt gesetzt.

Die drei Punkte (…) werden in Zitaten verwendet, um alle Auslassungen zu kennzeichnen.

Auch hier liefert der Verfasser mit der Forderung „ … den bedingungslosen Einsatz … der Punkte … 

bei Auslassungen“ [3], ein gutes Beispiel.

Bei drei Punkten am Ende eines Zitates wird „ … dringend der Punkt nach der Quellenangabe gesetzt 

…“ [3].

Die Abkürzungen „ f.“ und „ ff.“ stehen für die Folgeseite bzw. die Folgeseiten.

Verweise zu Quellen sind in eckigen Klammern auszuführen, wie beispielsweise nachstehend für 

die 37. BImSchV. [1]
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2 Hinweise zum Textteil

2.6 Fußnoten

Kurzworte (z. B. REA1), fremdsprachige (z. B. Betula pendula2) und fachgebietsfremde Fachbegriffe 

sowie Markennamen (z. B. PERSIL3) sind auf der Seite der ersten Nennung mittels einer Fußnote zu 

erklären. Dies Erfolgt mit Hilfe des Befehls \footnote{Beschreibung}, wie hier aufgeführt. 

Fremdsprachige Begriffe sind außerdem mit kursiv zu schreiben.

2.7 Kopfzeile

In der Kopfzeile steht rechtsbündig der Titel des jeweiligen Kapitels (außer auf der ersten 

Kapitelseite). Die Kopfzeile wird in dieser Vorlage automatisch gefüllt (eingestellt in der Preambel 

des Dokuments).

2.8 Abbildungen und Tabellen

Beschriften Sie alle Abbildungen mit Bildunterschrift und Tabellen mit Tabellenüberschrift (siehe 

Abb. 2.1 sowie Tabelle 2.1). Auf alle Abbildungen und Tabellen muss(!) im Text verwiesen werden. 

Dies Erfolgt mithilfe des Befehls \cref{VerweisID}.

Tabellen sollten möglichst schlicht gehalten werden. Verzichten Sie nach Möglichkeit auf vertikale 

Linien und benutzen sie die Voreinstellung in diesem Dokument. Ist es jedoch zum Verständnis 

notwendig, so können weitere Rahmenlinien hinzugefügt und/oder Zellen farbig hinterlegt werden.

Versuchen Sie, Abbildungen so zu gestalten, dass sie auch bei Schwarz-/Weiß-Druck erkennbar sind, 

z. B. durch verschiedene Linientypen.

Zentrieren Sie Ihre Grafiken und Tabellen sowie die entsprechenden Über- und Unterschriften. 

Abbildungen und Tabellen sollten nicht von Text „ umflossen“ werden. Als Beispiel wird ebenfalls 

auf Abb. 2.1 verwiesen.

Abb. 2.1: Bildunterschrift

1 REA: gebräuchliches Kurzwort für Rauchgasentschwefelungsanlage
2 Betula pendula: lat. für Hänge-Birke
3 PERSIL: Vollwaschmittel, eingetragene Marke der Henkel AG, Düsseldorf
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2 Hinweise zum Textteil

Am Ende der Arbeit wird je ein entsprechendes Verzeichnis eingefügt, welches in dieser Vorlage 

bereits eingerichtet ist. Abbildungen aus dem Anhang werden hier nicht aufgeführt.

Tabelle 2.1: Tabellenüberschrift

Spalte 1 Spalte 2 Spalte 3

Text Text Text
Text Text Text

Quelltexte und große Grafiken (im Format einer Seite) sollten in den Anhang verschoben werden, 

es sei denn der Lesefluss wird dadurch erheblich gestört. Dies ist z. B. der Fall, wenn die Grafik 

einen Abschnitt zusammenfasst. (nach [3])

2.9 Farben

Die Hausfarbe der TU Dresden ist das Blau (Primärblau):

— CMYK 100/80/5/0

— RGB 0/0/140

— HEX #00008C

Zudem sind 9 Sekundärfarben in Farbsets von jeweils zwei Helligkeiten sowie ein Grauton definiert.

Die Farbtöne sind so gewählt, dass eine maximale Unterscheidbarkeit gewährleistet ist. Sie sind für 

eine gute Lesbarkeit durch ausreichenden Kontrast der dunklen Farbtöne mit weißem Text und der 

hellen Farbtöne mit schwarzem oder dunkelblauem Text optimiert.

Zudem sind unterschiedliche Sekundärfarben im HKS-System definiert. Die TUD-Farbdesigns (TUD, 

SINS, DRESDEN-concept) können im Intranet heruntergeladen werden (ZIP-Archiv) oder in 

Abschnitt B nachgeschlagen werden.

2.10 Formeln

Nutzen Sie für Gleichungen Umgebung \begin{itemize}, wie folgt:

𝑓(𝑥) = 𝑎0 +
∞

∑
𝑛=1

(𝑎𝑛 ⋅ cos (𝑛𝜋𝑥
𝐿

) + 𝑏𝑛 ⋅ cos (𝑛𝜋𝑥
𝐿

)) (2.1)

Weitere Hinweise zu Formeln und Einheiten, diese werden aber automatisch in LaTeX durch die 

math- und siunitx-Umgebung formatiert:

— Formelzeichen werden kursiv geschrieben

— Indizes werden grundsätzlich nicht kursiv geschrieben, außer es handelt sich um Laufvariablen

— Mehrere Indizes können durch Leerzeichen oder Komma getrennt werden

— Einheiten werden nicht kursiv geschrieben

— Einheiten werden von Zahlenwerten durch ein geschütztes Leerzeichen getrennt
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2 Hinweise zum Textteil

2.11 Sonstige Hinweise zu Text und Formatierung

— Abkürzungen bei ihrer Erstnennung in ausgeschriebener Form einführen

— Zahlen bis zwölf werden ausgeschrieben, Zahlen ab 13 als Zahl geschrieben

— Einheitliche Farben in der ganzen Arbeit verwenden (gerne die des Corporate Designs der TU 

Dresden)

— Passiv („ werden“) nicht zu oft verwenden

— Füllwörter vermeiden

— Kein „ ich“

— Piktogramme, die TUD spezifisch sind, können aus dieser Seite heruntergeladen werden: 

https://intranet.tu-dresden.de/spaces/TUDMarke/pages/403965507/Icons
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3 Druck, Abgabe und Veröffentlichung der Arbeit

3 Druck, Abgabe und Veröffentlichung der Arbeit

3.1 Druck und Bindung

Die Arbeit ist in gebundener Form, ausgedruckt auf weißem Papier, Format DIN A4, abzugeben.

Prüferexemplar(e) für Begutachtung und Archivierung:

— In zweifacher Ausfertigung für Abschlussarbeiten (Diplom- / Bachelor- / Masterarbeit), in 

einfacher Ausfertigung für sonstige Arbeiten (z. B. Studienarbeit).

— Einseitiger Druck (auf Wunsch auch doppelseitig möglich, sprechen Sie mit ihrer/m Betreuer/in)

— 100 g/m²

— Originalaufgabenstellung anstelle des Platzhalters einfügen (bei Abschlussarbeiten Kopie der 

Aufgabenstellung ins Zweitexemplar einfügen)

— Feste Bindung

— Beschriftung hinzufügen: Rücken und Deckel mit Art der Arbeit und Nr. (z. B. DA 03/2019 oder 

StuArb 05/2018 oder PA 04/2019 etc.). Deckel gern auch mit Ihrem Namen und dem Titel der 

Arbeit beschriften (nicht obligatorisch, da Arbeit durch die Nummer identifiziert wird).

— Die Nummer der Arbeit ist aus der Aufgabenstellung zu entnehmen

Nach Absprache ein zusätzliches Betreuerexemplar: Sprechen Sie mit Ihrem/r Betreuer/in ab, ob 

er/sie ein zusätzliches Exemplar benötigt. Hier können Druck, Bindung und Beschriftung individuell 

abgesprochen werden.

Muster hierzu können im Zweifelsfall in der Professur eingesehen werden.

3.2 Abgabe der Arbeit

Abschlussarbeiten (DA/BA/MA) sind im Prüfungsamt abzugeben, sonstige Arbeiten (z. B. 

Studienarbeiten) beim betreuenden Hochschullehrer.

3.3 Elektronische Form

Die Abschlussarbeit ist in einem maschinengeschriebenen und gebundenen Exemplar sowie in 

digitaler Textform auf einem geeigneten Datenträger (siehe Abschnitt D) einzureichen.

Darauf ist die Arbeit als Datei (pdf und ggfs. auch Word-Datei, Aufgabenstellung eingescannt an 

vorgegebener Stelle hinzufügen!), alle erstellten elektronischen Modelle, Simulationen, 

Programme, Zeichnungen, Fotos, Vorlagen, Rechnungen usw. jeweils in weiter bearbeitbaren 

Formaten (SolidWorks, AutoCAD, Corel, Cosmos, Fluent, ComSol, jpg, bmp, MathCAD, ...) und 

recherchiertes Material (Quellen), das Ihnen in elektronischer Form vorliegt (Zeitschriftenartikel, 

Scans, Auszüge aus Büchern, e-books, ...), mit abzulegen.

Sämtliche Dateien sind unverschlüsselt abzuspeichern.
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3 Druck, Abgabe und Veröffentlichung der Arbeit

3.4 Veröffentlichungen

Studentische Arbeiten sind als wissenschaftliche Arbeiten öffentlich zugänglich. Sollte die Arbeit 

vertrauliche Informationen enthalten, die nicht veröffentlicht werden können, so ist der Textteil 

zumindest so zu verfassen, dass wissenschaftlicher Hintergrund, Lösungsweg und grundsätzliche 

Aussagen vom Leser nachvollziehbar sind. Dies ist z. B. durch normierte Diagramme und 

Prinzipdarstellungen möglich. Vertrauliche Daten sind in diesem Fall in einem nicht öffentlichen 

Anlageteil beizufügen, der nur den Gutachtern zur Prüfung der Arbeit zugänglich ist. (aus [2])
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4 Betreuung

4 Betreuung

Eine Betreuung der Studierenden ist insbesondere bei Diplomarbeiten unerlässlich. Um diese für 

beide Seiten möglichst effizient zu gestalten, ist es ratsam, folgende Punkte zu beachten:

— Vor jedem Gespräch ist ein Termin (telefonisch, E-Mail) zu vereinbaren.

— Die Fragen und Diskussionspunkte sind zuvor von der Studentin oder dem Studenten 

stichpunktartig schriftlich zu fixieren. Um Redundanzen zu vermeiden, ist es ratsam, auch die 

Ergebnisse zu notieren. [3]

— Es sollte frühzeitig eine Gliederung erstellt werden, die mit dem/r Betreuer/in diskutiert werden 

kann. [3]

Die aktuell zu vergebenden Beleg- und Diplomarbeitsthemen können an der Professur erfragt 

werden (Dr. rer. nat. Peter Stange, +49 351 463-32308, peter.stange@ tu-dresden.de) und werden 

auf der Homepage der Professur 

(https://tu-dresden.de/ing/maschinenwesen/iet/gewv/studium/studentische-arbeiten) 

publiziert.
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5 Zusammenfassung und Ausblick

5 Zusammenfassung und Ausblick

Die Arbeit wird durch eine Zusammenfassung und einen Ausblick abgeschlossen. Dieser bildet in 

diesem Sinne das Gegenstück zur Einleitung, d. h. hier werden die dort beschriebenen Ziele und 

der verwendete Weg kritisch beleuchtet.

Zum Schluss noch ein paar allgemeine Hinweise:

— Legen Sie Wert auf den roten Faden! Beschreiben Sie stets Ihren Weg durch das Thema so, 

dass er problemlos nachvollzogen werden kann. Die Einleitung bietet hier Raum für einen 

Überblick, sparen Sie nicht an einleitenden und zusammenfassenden Sätzen für Abschnitte 

der Ebene 1.

— Verdeutlichen Sie komplexe Zusammenhänge grafisch! Ohne in Marketing-Icons zu 

verfallen, hilft oft eine einfache Grafik, um komplexe Zusammenhänge zu verdeutlichen.

— Vergessen Sie nicht Ihre Unterschrift unter der Eidesstattlichen Erklärung! Kontrollieren 

Sie sicherheitshalber jedes Exemplar vor der Abgabe!

— Kontrollieren Sie die Vollständigkeit der Exemplare! Achten Sie darauf, dass sich die 

Formatierung aufgrund von unterschiedlichen Druckern (Ihr Drucker und der Drucker im 

Copy-Shop) ändern kann.
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6 Hinweise zur Erstellung eines Barrierefreien Dokumentes

6 Hinweise zur Erstellung eines Barrierefreien 
Dokumentes

Gemäß BITV 2.0 § 2a ist die TUD verpflichtet, alle Dokumente, welche auf der Webseite und im 

Intranet zur Ansicht oder zum Download zur Verfügung gestellt werden, barrierefrei umzusetzen. 

Für die Veröffentlichungen barrierefreier PDF-Dokumente ist die Norm DIN ISO 14289 – PDF/UA 

anzuwenden.

Daher müssen alle Dokumente bereits bei der Erstellung auf diese Anforderungen vorbereitet sein.

Auf den folgenden Seiten möchten wir Ihnen eine kurze Anleitung geben, wie Sie Ihre Dokumente 

so erstellen, dass diese für mehr Menschen zugänglich sind.

Dieses Dokument entstand in Zusammenarbeit des Dezernat 7 und der Professur Mensch-Computer 

Interaktion der TU Dresden.

6.1 Grundlagen

Achten Sie bei der Erstellung Ihres Dokuments auf die folgenden Punkte, um die Basis für ihr 

zugängliches Dokument zu schaffen:

— Visuelle Eigenschaften (Schriftart, Größe, Farbe, Auszeichnung) von Texten in Formatvorlagen 

organisieren

— Positionieren von Texten nicht über Leerzeichen und Leerzeilen, sondern mit Seitenumbrüchen 

und einstellbaren Abständen zwischen Absätzen

— Vermeiden manueller oder automatischer Worttrennungen, da diese bei der Umwandlung in 

die PDF meist nicht korrekt umgesetzt werden

— Verzicht auf separate Textfelder, da die digitale Lesereihenfolge der Elemente nach der 

Konvertierung oft nicht der optischen Lesereihenfolge entspricht

— Für Listen, Links und Querverweise, Verzeichnisse und Tabellen die dafür vorgesehene LaTeX-

Funktionen benutzen

— Bilder und Grafiken mit Alternativtexten versehen mithilfe von dem Befehl 

\pdftooltip{objekt}{Beschreibung}

— Automatisches Inhaltsverzeichnis erzeugen (ist bereits in diesem Dokument, muss nichts 

weiter gemacht werden)

6.2 Kontrast

Die Farben des CD der TUD und des SINS sind im Hinblick auf ausreichende Kontrastverhältnisse 

ausgewählt. Besonders bei Schrift/Farbkombinationen und der Verwendung anderer Farbwerte 

muss auf die Einhaltung der Kontrastwerten geachtet werden. Einen Kontrastrechner für Print- 

und Webanwendung bietet die Website leserlich.info an oder das kostenfreie Programm Colour 

Contrast Analyzer (CCA), mit dem programmunabhängig alle Bildschirminhalte geprüft werden 

können.
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6 Hinweise zur Erstellung eines Barrierefreien Dokumentes

6.3 Listen

Um Listen zu erstellen, nutzen Sie die vordefinierten Listenformate itemize und enumerate, dies 

führt zu einer korrekten Konvertierung nach PDF.

Für Listen gilt:

— Vordefinierte Listenformate führen zu einer korrekten Konvertierung nach PDF

— Das grafische Zeichen des Listenanstrichs ist z. B. für blinde Lesende nicht zugänglich

— Ein Plus-Zeichen für positive und ein Minus-Zeichen für negative Merkmale sind allein 

ungeeignet

— Eine textuelle Alternative des Listenzeichens muss bei inhaltlicher Relevanz angegeben werden

6.4 Tabellen

Für zugängliche Tabellen gilt Folgendes:

— Die Kopfzeile der Tabelle muss als Überschrift ausgezeichnet werden und sich bei mehrseitigen 

Tabellen auf jeder Seite wiederholen. Dies kann über den Befehl \tagpdfsetup{table/header-
rows={1}} eingestellt werden.

— Komplexe, mehrdimensionale, verschachtelte Tabellen sollten auf mehrere einfache Tabellen 

verteilt werden. Komplexe Tabellen sind für blinde Menschen schwer bzw. nicht lesbar und 

das Auszeichnen von Überschriften funktioniert in MS Word nur für Zeilen einfacher Tabellen.

6.5 Links und Querverweise

Links oder Querverweise im Dokument sollten aktive Verknüpfungen sein. In Ihrem Dokument 

führen solche den Leser zu dem verweisenden Element.

Für externe Verweise ist der Befehl url{} zu verwenden, oder der Befehl href{}, wie in diesem 

Dokument mehrmals durchgeführt wurde.

Querverweise innerhalb eines Dokumentes beispielsweise auf Tabellen, Abbildungen oder 

Überschriften können auch über die Befehle \cite{} oder \cref{} eingefügt werden. Dies wurde 

ebenfalls schon mehrmals aufgeführt.

Um Kapitel und Unterkapitel mit \cref{Überschrift} zitieren zu können sollte hinter jeder 

relevanten \section{Überschrift], \subsection{Überschrift} oder 

\subsubsection{Überschrift} eine gleichnamige \label{Überschrift} stehen, die eine 

Referenz-ID dem Abschnitt zuordnet. Dazu dient ebenfalls dieses Dokument als Beispiel.

6.6 Alternativtexte für Bilder und Grafiken

Für Bilder und Grafiken ist zu beachten, dass diese eine aussagekräftige Alternativbeschreibung 

benötigen, um auch für blinde Menschen zugänglich zu sein.

Folgende Informationen sollten je nach Kontext und abhängig vom Zweck des Bildes in der 

Beschreibung enthalten sein:
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6 Hinweise zur Erstellung eines Barrierefreien Dokumentes

— Absicht/Zweck des Bildes

— abgebildeter Ort

— Objekte, Gebäude, Menschen

— Emotionen, Atmosphäre

— Was passiert im Bild?

— Farben (allerdings ist in Diagrammen die Beschreibung visueller Attribute nur nötig, wenn 

dadurch Zusatzinformationen geliefert werden)

— Beziehen Sie nur Informationen ein, die nicht auf andere Art erreichbar sind, z. B. sollten Sie 

nicht einfach nur die Bildunterschrift wiederholen.

Eine gute Bildbeschreibung sollte folgende Eigenschaften besitzen:

— Objektivität (keine eigene Interpretation einbringen)

— Verständlichkeit (unter Beachtung der Zielgruppe)

— Sinnhaftigkeit (Beschreibung muss außerhalb und innerhalb des Kontextes Sinn ergeben)

— Eindeutigkeit und Einhaltung von fachdidaktischem Wissen

— Effektivität (Informationen vollständig, aber möglichst kurz/prägnant halten)

— Beispiele für sinnvolle Bildbeschreibungen finden Sie an den Bildern innerhalb dieses 

Dokumentes.
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7 Barrierefreies PDF erzeugen

7 Barrierefreies PDF erzeugen

7.1 Metadaten

In der Preambel des main.tex Dokuments sollten mindestens die folgenden Angaben eingetragen 

werden (relevant auch für die Anzeige des PDFs in Suchmaschinenergebnissen):

 % #Sprache: de-DE für Deutsch en-US
 % #Titel: Titel der Studentischen Arbeit
 % #Name: Vorname und Nachname des Autors der Arbeit
 % #Arbeitsart: Diplomarbeit, Masterarbeit, Studienarbeit, Bachelorarbeit, etc.
 % #weitere-keywords: Falls weitere keywords nötig sind, gerne einfügen
\hypersetup{
 pdflang={#Sprache},
 pdftitle={#Titel},
 pdfauthor={#Name},
 pdfsubject={#Arbeitsart},
 pdfkeywords={TU Dresden, Gebäudeenergie und Wärmeversorgung, #weitere-keywords}
}

7.2 Link/QR-Code zum digitalen Dokument

Jedes gedruckte Dokument erhält auf der Rückseite einen Link und den zugehörigen QR-Code zur 

digitalen Version des Dokuments bzw. einer Website mit entsprechendem Inhalt. Eine Ausführliche 

Anleitung stellt die AG SBS der TU Dresden zur Verfügung.

7.3 Kontrolle des PDF

Die PDF-interne Barrierefreiheitsprüfung ist nicht ausreichend für ein barrierefreies Dokument. 

Das erzeugte PDF muss in der Regel manuell kontrolliert werden, um Details zu optimieren und 

Fehler zu beheben.

Schritte: PDF erstellen und öffnen > Bookmarks öffnen und Struktur kontrollieren > ggf. Tagstruktur 

überprüfen.

Empfehlenswert ist die Installation des (nach Registrierung) kostenfrei downloadbaren Plugins 

Commonlook PDFgoHTML 2, das die Struktur des PDFs sehr anschaulich im Browser darstellt. Eine 

Alternative ist der PDF accessibility Checker (PAC) 3.
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8 Checklisten

8 Checklisten

8.1 Checkliste barrierefreies Dokument

— Alle relevanten Elemente vorhanden?

— Absatzformate getagged?

— Dokumentstruktur korrekt (Überschriftenhierarchie)?

— (automatisches) Inhaltsverzeichnis angelegt?

— Lesereihenfolge aller Elemente korrekt?

— alle Bilder, Grafiken mit alternativem Text?

— Metadaten eingefügt?

— Link/ QR-Code zum digitalen Dokument vorhanden?

— Sprache, Rechtschreibung einheitlich zugewiesen?

— Links überprüft?

— manuelle Zeilenumbrüche und Silbentrennungen, leere Absätze entfernt?

— nicht relevante Elemente als „ artifact“ getagged oder auf Musterseite gelegt?

— Kontraste überprüft?

— Bookmarks und Tags im PDF Dokument korrekt?
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Symbolverzeichnis

Symbolverzeichnis

Abkürzungen

AHK Abhitzekessel

AP Arbeitspaket

BS Brennstoff

COP Coefficient of Performance (Leistungszahl)

EFH Einfamilienhaus

GuD Gas und Dampf

Formelzeichen

𝛼 Wärmeübergangskoeffizient W m−2 K−1

A Fläche m2

a Kohäsionsdruck MPa

E Exergie

Indizes

Aus,aus Austritt

BK Brennkammer

BS Brennstoff

el elektrisch

KÜHL Kühlung

L Luft

th thermisch

TW Trinkwasser
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A Anhang XYZ

A Anhang XYZ

Hier sind Ausdrucke von Quelltexten oder MathCAD-Dokumenten, große Grafiken und Diagramme 

und Fotoserien gut aufgehoben.

A.1 Einbinden von PDF-Dokumenten

Beispiel:

\includepdf[pages=-]{anhang/dateiname.pdf}

A.2 Einbinden von Quelltext

Beispiel:

\lstinputlisting [caption={VBS-Quellcode}
 \label{lst:javaclass},
 captionpos=t,language=VBscript]
{pfadname/dateiname.vbs}

A.3 Einbinden von Bildern

Zum Einbinden von Bildern soll vorzugsweise die folgende Konvention in der Umgebung 

\begin{figure} verwendet werden:

% #bildgröße = Größe des Bildes im Bezug auf die Zeilenbreite
% #datei-name = Name der Datei im Ordner (pdf, png oder jpg verwenden)
% #alternativtext = Beschreibung des Bildes, die im Dokument nicht sichtbar ist und für Screen Reader angezeigt wird
% #bildunterschrift = Beschreibung des Bildes die im finalen Dokument zu sehen wird
\begin{figure}[htb]
 \centering
 \includegraphics[width=#bildgröße\linewidth, alt={#alternativtext}]{abbildungen/#datei-
name}
 \caption{#bildunterschrift}
 \label{fig:#datei-name}
\end{figure}
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B Farben der TUD

B Farben der TUD
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Blau 1
Hex #2F57B2
RGB 47 / 87 / 178
CMYK 90 / 50 / 0 / 0
NCS 3050-R90B

Standard 
Farbe 1

Standard 
Farbe 2

Violett 1
Hex #7369BE
RGB 115 / 105 / 190
CMYK 64 / 62 / 0 / 0
NCS 2050-R60B

Magenta 1
Hex #BC1589
RGB 188 / 21 / 137
CMYK 30 / 96 / 0 / 0
NCS 2060-R40B

Rot 1
Hex #D20F41
RGB 210 / 15 / 65
CMYK 0 / 100 / 60 / 0
NCS 1080-R

Orange 1
Hex #C85000
RGB 200 / 80 / 0
CMYK 0 / 90 / 100 / 20
NCS 2075-Y70R

Gelb 1
Hex #FFC700
RGB 255 / 199 / 0
CMYK 0 / 25 / 100 / 0
NCS 0580-Y10R

Oliv 1
Hex #767A23
RGB 118 / 122 / 35
CMYK 50 / 35 / 100 / 22
NCS 4040-G80Y

Grün 1
Hex #007D4B
RGB 0 / 125 / 75
CMYK 90 / 0 / 80 / 15
NCS 3050-G

Türkis 1
Hex #0A777F
RGB 10 / 119 / 127
CMYK 100 / 10 / 30 / 40
NCS 3060-B10G

Blau 2
Hex #97C6FF
RGB 151 / 198 / 255
CMYK 43 / 15 / 0 / 0
NCS 1040-R90B

Violett 2
Hex #C8C8FF
RGB 200 / 200 / 255
CMYK 20 / 20 / 0 / 0
NCS 0520-R60B

Magenta 2
Hex #FFB9FF
RGB 255 / 185 / 255
CMYK 0 / 30 / 0 / 0
NCS 0520-R40B

Rot 2
Hex #FFAAA5
RGB 255 / 170 / 165
CMYK 0 / 44 / 27 / 0
NCS 1030-R

Orange 2
Hex #FFBE78
RGB 255 / 190 / 120
CMYK 0 / 30 / 55 / 0
NCS 1030-Y30R

Gelb 2
Hex #FFE483
RGB 255 / 228 / 131
CMYK 0 / 5 / 50 / 0
NCS 0530-G90Y

Schwarz
Hex #000000
RGB 0 / 0 / 0
CMYK 0 / 0 / 0 / 100
NCS 9000-N

Weiß
Hex #FFFFFF
RGB 255 / 255 / 255
CMYK 0 / 0 / 0 / 0
NCS 0300-N

Oliv 2
Hex #D2DC46
RGB 210 / 220 / 70
CMYK 25 / 0 / 81 / 0
NCS 0550-G60Y

Grün 2
Hex #8CE6AA
RGB 140 / 230 / 170
CMYK 45 / 0 / 45 / 0
NCS 2030-G10Y

Türkis 2
Hex #8CE6D7
RGB 140 / 230 / 215
CMYK 45 / 0 / 20 / 0
NCS 1030-B30G

Grau 100 %
Hex #323F4B
RGB 50 / 63 / 75
CMYK 45 / 20 / 5 / 80
NCS 8005-R80B

Grau 80 %
Hex #566371
RGB 86 / 99 / 113
CMYK 36 / 16 / 4 / 64
NCS 7005-R80B

Grau 60 %
Hex #7D8894
RGB 125 / 136 / 148
CMYK 27 / 12 / 3 / 48
NCS 5005-R80B

Grau 40 %
Hex #A5AEB8
RGB 165 / 174 / 184
CMYK 18 / 8 / 2 / 32
NCS 3005-R80B

Grau 20 %
Hex #D0D5DC
RGB 208 / 213 / 220
CMYK 9 / 4 / 1 / 16
NCS 1005-R80B

Grau 10 %
Hex #E7E9ED
RGB 231 / 233 / 237
CMYK 5 / 2 / 1 / 8
NCS 0505-R80B

Dunkelblau
Hex #001450
RGB 0 / 20 / 80
CMYK 100 / 70 / 10 / 60
NCS 7020-R70B

Brillantblau
Hex #00008C
RGB 0 / 0 / 140
CMYK 100 / 80 / 5 / 0
NCS 3060-R80B



C Einrichten der Arbeitsumgebung

C Einrichten der Arbeitsumgebung

Zur Einrichtung der Arbeitsumgebung sind folgende Schritte erforderlich:

1. Installation der Schriften „ Noto Sans“ und „ Noto Sans Semibold“ über

https://intranet.tu-dresden.de/spaces/TUDMarke/pages/403965504/Schrift

2. Alternativ zu 3., 4. kann auch ShareLatex oder Overleaf benutzt werden. In dem Fall sind auch 

keine weiteren Einstellungen in 9. für das Symbolverzeichnis nötig. Die Literaturdatenbank 

kann in dem Fall direkt über quellen.bib bearbeitet werden, wie in 8.

3. Installation der Latex-Distribution „ Miktex“ über

https://miktex.org/

4. Installation von Texmaker über

http://www.xm1math.net/texmaker/download.html
oder Installation von Texstudio über

https://www.texstudio.org/#download

5. Entpacken der zur Vorlage gehörenden Ordnerstruktur

6. Den Compiler auf LuaLaTeX umstellen:

Bei Sharelatex über: File -> Settings -> Compiler -> Compiler -> LuaLaTeX

Bei TeXStudio über: Options -> Configure TeXstudio -> Build -> Default Compiler -> 

txs:///lualatex auswählen

Bei TeXmaker über: Options -> Configure Texmaker -> Quick Build -> Quick Build Command -> 

LuaLaTeX

7. Wahlweise: Installation von JabRef für das Editieren der Literaturdatenbank (quellen.bib) über

http://www.jabref.org/

8. Die Literaturdatenbank kann auch direkt über quellen.bib verwaltet werden und muss nicht 

über Jabref erfolgen

9. Um das Symbolverzeichnis über TeXstudio korrekt anzuzeigen (bei Sharelatex passiert dies 

automatisch) muss folgendes eingestellt werden:

Options -> Configure TeXstudio -> Build -> bei User Commands folgendes reinfügen bei user0: 

makeindex -s nomencl.ist -o \%.nls \%.nlo und bei Build & View einfügen: 

txs:///compile | txs:///user0 | txs:///compile | txs:///view

Für Miktex sollte das automatische Nachladen nicht vorhandener Pakete aktiviert werden.

Im Arbeitsrhytmus wird das Übersetzen nicht immer aus der Oberfläche der Masterdatei erfolgen. 

Da Texmaker die Masterdatei nicht automatisch erkennt, sollte diese zu Beginn einer Sitzung über 

das Menü „Optionen“ definiert werden.

Es besteht die Möglichkeit, dass die zur Vorlage gehörende Ordnerstruktur in einem Repository 

eingerichtet wird. Dies ermöglicht eine Versionierung, vor allem aber die Teamarbeit und damit 

eine bessere Betreuung. Wenn dies erwünscht ist, sind folgende Schritte erforderlich:

— Installation des IET-Chat-Clients („ RocketChat“)

über https://rocket.chat/install
Alternativ kann auch über einen Internetbrowser auf den Dienst zugegriffen werden. Dazu ist 

im Browser die Adresse aus dem nachstehenden Spiegelstrich einzugeben.
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C Einrichten der Arbeitsumgebung

— Eingabe der Server-Adresse

https://messaging-service.gewv.iet.mw.tu-dresden.de

— Anmelden mit dem persönlichen ZIH-Login und -Passwort

— Nach erfolgreicher Anmeldung ist eine Information mit Angabe der Betreuenden 

an Dr. Lars Haupt per Mail (lars.haupt@tu-dresden.de) erforderlich. Dr. Haupt übernimmt die 

Einrichtung des Repository und informiert über RocketChat.

— RocketChat kann dann weiterhin für die Kommunikation mit den Betreuenden genutzt werden.
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D Hinweise zum Setzen von Text in der bereitgestellten LaTeX-Vorlage

D Hinweise zum Setzen von Text in der 
bereitgestellten LaTeX-Vorlage

— Nur falls Texmaker benutzt wird: Zu Beginn jeder Sitzung sollte in Texmaker unter „Optionen“ 

die Masterdatei definiert werden.

— Nur falls Texmaker benutzt wird: Zum Übersetzen wird in Texmaker „ Schnelles Übersetzen“ 

ausgewählt.

— Nur falls Texmaker benutzt wird: Zum Einbinden der Literatur ist bei Texmaker in den 

Modus „ Bibtex“ zu wechseln.

— Zum Setzen von Grafiken sollten die im Anhang Abschnitt A.3 vorgestellten Vorlagen verwendet 

werden.

— Alle Grafiken sollten separat in der Ablage „ abbildungen“ abgelegt werden. Damit ist ein 

einfaches Auffinden und Anpassen der Grafiken gewährleistet.

— Nur falls Texmaker benutzt wird: Bei hartnäckigen Übersetzungsfehlern hilft mitunter die 

Funktion „Aufräumen“ des Texmakers.

— Bei der Einbindung von Bildern hat sich bewährt, dass das Label mit dem Dateinamen des 

Bildes übereinstimmt.

— Die Notwendigkeit zur Installation weiterer Pakete bitte sorgfältig abwägen und mit den 

Betreuenden absprechen. Das System sollte möglichst schlank gehalten werden.

— Es sollten deutsche Anführungszeichen unter Nutzung des Befehls \enquote{} gesetzt werden.

— Fragen und Anregungen zur Vorlage können gern an Alex Blandón per 

Mail (alex.blandon@mailbox.tu-dresden.de) gerichtet werden.
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Eidesstaatliche Erklärung

Hiermit versichere ich, Vorname Nachname, dass ich die vorliegende Arbeit ohne unzulässige Hilfe 

Dritter und ohne Benutzung anderer als von mir angegebener Hilfsmittel angefertigt habe; die aus 

fremden Quellen direkt oder indirekt übernommenen Gedanken sind als solche kenntlich gemacht. 

Bei der Auswahl und Auswertung des Materials sowie bei der Herstellung des Manuskripts habe 

ich Unterstützungsleistungen von folgenden Personen erhalten:

………………………………………………………………………………….

Weitere Personen waren an der geistigen Herstellung der vorliegenden Arbeit nicht beteiligt. Der 

Text wurde von mir selbst verfasst; es erfolgte kein Einsatz von KI zum Erstellen dieses Textes. Die 

Arbeit wurde noch keiner Prüfungsbehörde in gleicher oder ähnlicher Form vorgelegt.

Mir ist bekannt, dass die Nichteinhaltung dieser Erklärung zur nachträglichen Bewertung mit der 

Note „5“ führen kann.

Dresden, 19. März 2026

..........................................................

Vorname Nachname
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Datenträger

Hier kann der Inhalt des Datenträgers beschrieben werden, wie am Beispiel zu sehen. Der 

Datenträger beinhaltet folgende Inhalte:

1. Simulationsmodell

2. Studienarbeit_Max_Mustermann.pdf

3. Ordner: Datengruppe A

(a) Daten.csv

(b) Daten.xlsx

4. Ordner: Programmcodes

5. Ordner: Diagramme und Abbildungen
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